Spreadsheet models are a natural tool for managers but they can be hard to create from scratch and hard to understand and use if they're not well constructed.

This short guide provides tips on how to create a well-designed worksheet and also discusses some auditing techniques.
Specific references are to Excel 2000.

-Paula Ecklund
Spring 2001
Contents

I. Getting Started ........................................................................................................... 1
   Inputs
   Outputs
   Relationships

II. Data Entry and Organization ................................................................................. 2
    Constant Values
    Row-Column Structure
    The Final Report
    Documentation

III. Creating Formulas ................................................................................................ 6
    Numbers in Formulas
    Reproducing Formulas
    Relative and Absolute Addressing
    Simple Formulas
    Range Names
    Intermediate Quantities
    Flow of Calculation

IV. Auditing and Debugging Your Worksheet .......................................................... 9
    See the Organization of a Large Worksheet
    View Detailed Information About Cells
    Use the Excel's Auditor to Correct Problems and Examine Cell Relationships

V. For more Information ......................................................................................... 11
   Using Excel's Online Help
I. Getting Started

Before you begin building a worksheet, spend some time thinking about the data you're going to model and the problem you want to solve. Try to identify the inputs and outputs and the relationships among the data.

**Inputs**

*Known Values*
Any known values or given data. These are quantities you don't control. Do you need any additional data to build the model?

*Decision Variables*
Quantities you control and can manipulate to optimize your model's solution. In some cases, decision variable values may be efficiently optimized by using tools like Excel's Solver.

**Outputs**

*The Object*
What you're trying to solve, find, show, or optimize: the "bottom line".

*Any Constraints*
Limits to inputs or outputs, tradeoffs, conditions you must meet. Examples of constraints are budgetary limitations or limits to available resources.

**Relationships**

*Relationships Between Variables*
Relationships between the known values and decision variables, expressed in formulas. Not all the relationships may at first be clear, especially in a complex problem. They may become more clear as you work through the development of your model.

*A Pattern*
Whether or not your problem fits into a "family" of problems for which you might employ a generic model structure. For example, problems dealing with resource allocation or scheduling have traditional formats you might want to adopt for your model.
II. Data Entry and Organization

Organize your spreadsheet model around your data. Start building the model by entering the data you know about. You don't necessarily need to know just how you're going to use all the data before you enter it. At the start, just get the data into the spreadsheet. Excel makes it easy for you to change things around later if you need to.

**Constant values**

If possible, keep all constant values together in one area of the worksheet, clearly distinguished from decision variables and formulas. An important principle of good spreadsheet design is to keep just one copy of each constant value. That is, enter a constant value in only one location in the worksheet. Then if you use the value in another cell, use a cell reference that refers to the constant value's unique location.

Example: You enter the constant value of 6% for sales tax in cell E5. When you write a formula in your worksheet that requires sales tax, reference E5 in the formula instead of "hard coding" in the 6% value.  

\[ \text{Do: } \text{subtotal} \times E5 \]  
\[ \text{Don't: } \text{subtotal} \times 6\% \]

Better yet, assign cell E5 a name, like SalesTax. Then use that name in any formula you write. The formula in the example above would then read \( \text{subtotal} \times \text{SalesTax} \).

**Row-Column Structure**

Are there existing row or column structures in the data that you can exploit in your model's layout? For example, the data for the worksheet below was available in a tabular format that translates directly into this useful model layout.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Oak Products, inc: Optimum Product Mix Finder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Product:</td>
<td>Captain</td>
<td>Mate</td>
<td>AmHi</td>
<td>AmLo</td>
<td>SpanK</td>
<td>SpanQ</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>$36</td>
<td>$40</td>
<td>$45</td>
<td>$38</td>
<td>$36</td>
<td>$25</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5-10</td>
<td>Profit or Cost:</td>
<td>3100</td>
<td>1200</td>
<td>1900</td>
<td>170</td>
<td>1900</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11-15</td>
<td>Long dreme</td>
<td>0</td>
<td>0</td>
<td>12</td>
<td>0</td>
<td>8</td>
<td>4</td>
<td>1200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16-20</td>
<td>Short dreme</td>
<td>4</td>
<td>12</td>
<td>0</td>
<td>12</td>
<td>4</td>
<td>8</td>
<td>1900</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21-25</td>
<td>Leg</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>1900</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26-30</td>
<td>Heavy seat</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>190</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31-35</td>
<td>Light seat</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>170</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36-40</td>
<td>Heavy ring</td>
<td>6</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>1900</td>
<td></td>
<td></td>
</tr>
<tr>
<td>41-45</td>
<td>Light ring</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>6</td>
<td>1900</td>
<td></td>
<td></td>
</tr>
<tr>
<td>46-50</td>
<td>Captain rail</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>110</td>
<td></td>
<td></td>
</tr>
<tr>
<td>51-55</td>
<td>Mate rail</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>72</td>
<td></td>
<td></td>
</tr>
<tr>
<td>56-60</td>
<td>American rail</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>93</td>
<td></td>
<td></td>
</tr>
<tr>
<td>61-65</td>
<td>Spanish rail</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>95</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2
The Final Report

Give some thought at the start to what you might want a final report or reports to look like. What quantities should be computed and displayed in the reports? What's the most logical way in which to arrange them? What will the reports' readers be looking for? Is there information that should appear together on a single page? Do readers your readers need the option of seeing underlying formulas?

Documentation

General Documentation:
In an obvious place in the worksheet include general information that describes what the model is for, where the data is from, who the output is going to, etc.

Documenting Data:
When entering data, use descriptive labels to document data items.

Example:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sales Tax</td>
<td>6%</td>
</tr>
<tr>
<td>2</td>
<td>Inflation</td>
<td>8.20%</td>
</tr>
</tbody>
</table>

Not only can you include labels as text in worksheet cells, you can also name cells or groups of cells (ranges) and use those names in place of row-column references. This can make your worksheet much easier to read and modify.

Rules for naming a range:
- A range name can be of any length but can't contain spaces, commas, or hyphens.
- A name must start with an underscore or a letter and shouldn't look like a cell reference.

Examples of valid range names:
- Cost.of.Goods
- _Old_Data
- LongName1234
- OK1

Examples of invalid range names:
- Cost-of-Goods
- Old Data
- LongName 1 2 3
- A1
Here are three methods for naming a range:

**Method One:** Use *Insert, Name, Create* to create names for cells automatically based on their row or column headings. Select the range to name and issue the commands to get this dialog box and indicate where Excel should find the names to use.

**Method Two:** Use *Insert, Name, Define* to create a name for a range you specify. For example, if you select the range A1:B3 in the example at right and issue the *Insert, Name, Define* command, Excel presents a dialog box that assumes you want to name the entire range *Jan*. If this isn’t what you want, you can change the current selection.

**Method Three:** Use the name box on the Excel 5 formula bar. In the example here you might highlight A1:B2, then click in the part of the formula bar that now holds the cell reference A1 and type in a name for the range, like *Constant_data*.

**Documenting a Single Cell:**

If you want to document a cell but don’t want to display the documentation directly in a cell of the worksheet, use a comment. A comment is associated with a cell, but not part of it.

To create a comment, select the cell in question and enter the commands *Insert, Comment*. Excel displays a small text box in which to enter the comment.
Select Tools, Options and then the View tab to see your options regarding how comments are displayed. You can choose to display no comments, the comment indicator only (a red triangle at the upper-right-hand corner of a cell with an associated comment), or both the indicator and its comment.

If you have the first (no comments) option selected, you can still see what cells have comments associated with them by hitting F5 (which opens the Go To dialog), hitting the Special button, selecting “Comments”, and hitting OK. Excel selects every cell that has an associated comment.

If you have the second (comment indicator only) option selected, Excel shows the text of the comment when you position the mouse pointer over the indicator.

The Sheet tab on the Page Setup dialog lets you select how you want comments printed: Not at all, as displayed on the worksheet, or all together at the end.
III. Creating Formulas

Numbers in Formulas

Avoid using numbers (actual data) in formulas. Instead, use cell references that point to data cells. By keeping a data item in a unique location in the worksheet you can much more easily change the item and have the change affect the use of that item throughout the worksheet.

Example:
Cell E5 holds the data item 6%, for tax rate.
In all formulas that need to reference tax rate, refer to cell E5 instead of typing in 6%. If the tax rate later changes to 6.5% you can change the rate value one place in your worksheet. The value changes in every formula that refers to that cell and you need not locate and change every formula that uses the value.

Reproducing Formulas

You may often need to reproduce a formula in several places in a worksheet. In many cases, you can type in the formula one time and then copy it to the other locations, avoiding hard-to-detect typing errors. When copying formulas, be sure to understand how to use relative and absolute addressing, described below.

Relative and Absolute Addressing

For copied formulas, Excel uses relative addressing as the default. That is, Excel adjusts the cell references in your source formula when the formula is copied to new locations.

The worksheet at right shows three formulas in cells D4, D5, and D6. Because of this model's layout, there's no need to type in three formulas. Type in just the first formula in cell D4 and then copy it to cells D5 and D6.
This view of the same worksheet shows the contents of the formula cells. You can see that for each copied formula, Excel adjusted the cell references to refer to the data in the correct row.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tax:</td>
<td>0.05</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sales</td>
<td>Jan</td>
<td>Feb</td>
</tr>
<tr>
<td>4</td>
<td>Dept. 1</td>
<td>45</td>
<td>23</td>
</tr>
<tr>
<td>5</td>
<td>Dept. 2</td>
<td>38</td>
<td>42</td>
</tr>
<tr>
<td>6</td>
<td>Dept. 3</td>
<td>66</td>
<td>85</td>
</tr>
</tbody>
</table>

However, there may be occasions when you want to override Excel’s relative addressing default. In the example below, the formula in the Tax column makes use of the values in column D and the 5% value in cell B1.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tax:</td>
<td>5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sales</td>
<td>Jan</td>
<td>Feb</td>
<td>Total:</td>
</tr>
<tr>
<td>4</td>
<td>Dept. 1</td>
<td>45</td>
<td>23</td>
<td>$68</td>
</tr>
<tr>
<td>5</td>
<td>Dept. 2</td>
<td>38</td>
<td>42</td>
<td>$80</td>
</tr>
<tr>
<td>6</td>
<td>Dept. 3</td>
<td>66</td>
<td>85</td>
<td>$151</td>
</tr>
</tbody>
</table>

This view of the spreadsheet shows how the formulas appear. In order to properly copy the formula in E4 to cells E5 and E6, absolute addressing must be specified in the master formula in cell E4 for the 5% tax figure.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tax:</td>
<td>0.05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sales</td>
<td>Jan</td>
<td>Feb</td>
<td>Total:</td>
</tr>
<tr>
<td>4</td>
<td>Dept. 1</td>
<td>45</td>
<td>23</td>
<td>=SUM(B4:C4)</td>
</tr>
<tr>
<td>5</td>
<td>Dept. 2</td>
<td>38</td>
<td>42</td>
<td>=SUM(B5:C5)</td>
</tr>
<tr>
<td>6</td>
<td>Dept. 3</td>
<td>66</td>
<td>85</td>
<td>=SUM(B6:C6)</td>
</tr>
</tbody>
</table>

An absolute cell reference is indicated by putting a dollar sign before the row and column reference. In this example worksheet, cell B1 holds the tax value. When the cell reference is entered as $B$1 in a formula it indicates an absolute references to that cell. As an absolute reference, the reference won't change when the formula containing the reference is copied.

So when the master tax formula in cell E4 is copied down the column to cells E5 and E6, the reference to the tax rate remains correct, pointing to cell B1. Note, however, that the first cell references in the master tax formula (D4) is left relative. When it's copied in a formula, it becomes D5 and D6, which is also correct.
**Simple Formulas**

Keep formulas simple and straightforward. This makes them easier to read and to debug. If you need to express complex relationships, create several formulas and use them like building blocks instead of constructing an overly long formula.

**Range Names**

Use range names instead of cell references to make formulas easy to understand. (See the discussion above on naming and applying ranges.) If you assign a name to a cell or a range after you’ve used that cell or range in a formula, use the Insert, Name, Apply commands to have Excel use the name in formulas place of a cell reference. If you want the name to be used in place of any reference to that cell anywhere it might appear in the worksheet, select a single cell before issuing the commands. If you want the name applied to only a particular range, select that range before issuing the commands.

Example:

Formula without range names applied: \[=C10\times A3\]

Formula with range names applied: \[=\text{Subtotal}\times \text{Tax}\]

**Intermediate Quantities**

Arrange your model to show intermediate quantities of interest, such as subtotals.

**Flow of Calculation**

Try to plan the arrangement of worksheet formulas and labels so the flow of calculations is obvious.
IV. Auditing and Debugging Your Worksheet

See the Organization of a Large Worksheet

Use the commands View, Zoom to get the dialog box at right. Then specify how you want Excel to display your worksheet on the screen. If you ask for a low magnification (say 25 or 50%) you'll be better able to review your worksheet layout. Then return to regular 100% magnification to continue working.

View Detailed Information About Cells

Excel includes a number of tools that provide information about cells on a worksheet:

- **The Auditing Toolbar**
  You can locate the cells that supply data for formulas and find cells that depend on values in other cells by using the Auditing toolbar. To display the Auditing toolbar, point to Auditing on the Tools menu, and then click Show Auditing Toolbar.

Or, click Tools, Customize to open the “Customize” dialog box like the one at left. Locate the entry for the Auditing toolbar and click the box to its left to toggle it on.

More on using the Auditing Toolbar below.
• **Cell Comments**
You may find it useful to add comments to a cell, to include some documentation about a value or formula directly in the worksheet. Add a comment by right-clicking the cell and selecting *Insert Comment*. A comment box displays that works like the standard text box. View a comment by pointing to the cell that has the comment attached. Comments can be printed, either where the comment appears on the worksheet or at the end of the worksheet.

• **Cell Formatting**
To see the formatting applied to a cell, click the cell, and then click *Cells* on the Format menu. You can review each tab in the *Format Cells* dialog box to see the formats applied to the cell.

• **Cell/Range Name**
If you need to know whether a name refers to a cell, click the cell. The Name box at the left end of the formula bar displays either the address of the cell, such as A1, or the name that refers to the cell.

**Use Excel's Auditor to Correct Problems and Examine Cell Relationships**

Turn on the Auditing Toolbar with the commands *Tools, Auditing, Show Auditing Toolbar*. Use the tools on the Auditing toolbar to locate problems and display cell relationships.

For example, a circular reference occurs when a formula mistakenly refers to itself and thus can't be resolved. Click the problem cell and use the *Trace Error* button on the Auditing Toolbar to locate the error.

Click the cell whose dependents or precedents you want to locate and use the trace precedents or trace dependents icons on the Auditing Toolbar. Excel draws arrows on the worksheet to show relationships between cells. Use the erase precedent arrows icon or the erase dependent arrows icons to erase the arrows when you're through.
V. For More Information

Excel has extensive online help with a variety of access methods. You can get online help from within dialog boxes, via the menus, or courtesy of the Office Assistant.

For example, the “Paste Function” dialog box displays a help button. Choose whatever function you’re interested in and then click the help button to open information about that function in the online help.

If your Office Assistant is turned on, click the Help Button on the Standard Toolbar (or hit F1) to “open” it. Then click the Office Assistant cartoon character to open a space in which to type a question or term you want help with. Depending on the state of your spreadsheet when you invoke the Office Assistant, the Assistant may suggest some relevant help topics.

If you don’t want to see the Office Assistant in the workspace, right-click and choose Hide.

If you don’t want to use the Office Assistant at all, right-click and choose Options to open the Office Assistant options dialog. Then toggle off the “Use the Office Assistant” option.

Tip: Right click the Office Assistant and choose Animate to see the Assistant’s repertoire of tricks.
While the Office Assistant can be amusing and sometimes helpful, Excel 2000 has a much-improved online help system that’s worth getting to know. You can invoke it by turning off the Office Assistant and choosing the commands Help, Microsoft Excel Help.
Excel’s complete online help system displays in two windows: A navigation (subject) pane left and a topic (content) pane at right. The topic pane or both the topic and navigation panes can be open on top of the current worksheet, making it easy to follow online help instructions as you work.

Use the arrow icons at the upper left to control the display of the navigation pane.

There are three entrances into online help: “Contents”, the “Answer Wizard”, or the “Index”.

Underlined references in the topic pane are hyperlinks.

Drag to expand the panes to whatever size suits you.